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Frontispiece. Seismic reflection profiles from the flanks of the Demerara Rise. A. High-resolution
profile acquired during Meteor site survey M49-4, showing the shallow stratigraphy of Leg 207 target
sediments (mid-Cretaceous and younger). B. Industry reflection profile showing faulted and folded
Early Cretaceous synrift sediments overlain by mid-Cretaceous and younger sediments. Horizon C is a
significant regional unconformity that marks the transition from synrift deposition and trans-tensional
tectonics during the opening of the equatorial Atlantic to hemipelagic and pelagic deposition that
includes Cretaceous and Paleogene critical intervals that are the focus of Leg 207. Horizon B′ relates to
the top of the Cretaceous black shale sequence, and Horizon B correlates to the K/T boundary.
Horizon A is an early Miocene erosional unconformity that removed much of the Neogene succession
from the flanks of the Demerara Rise.
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Reference to the whole or to part of this volume should be made as follows: 

Print citation for Chapter 1:
Shipboard Scientific Party, 2004. Leg 207 summary. In Erbacher, J., Mosher, D.C., Malone, M.J., et al., 
Proc. ODP, Init. Repts., 207: College Station TX (Ocean Drilling Program), 1–89.

CD-ROM volume citation:
Erbacher, J., Mosher, D.C., Malone, M.J., et al., 2004. Proc. ODP, Init. Repts., 207 [CD-ROM]. Available 
from: Ocean Drilling Program, Texas A&M University, College Station TX 77845-9547, USA.

CD-ROM chapter citation:
Shipboard Scientific Party, 2004. Site 1257. In Erbacher, J., Mosher, D.C., Malone, M.J., et al., Proc. 
ODP, Init. Repts., 207, 1–111 [CD-ROM]. Available from: Ocean Drilling Program, Texas A&M 
University, College Station TX 77845-9547, USA.

This volume also appears on the World Wide Web. See www-odp.tamu.edu/publications for Web 
citation formats.

http://www-odp.tamu.edu/publications
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Effective publication dates of ODP Proceedings

According to the International Code of Zoological Nomenclature, the date of publication of a work 
and of a contained name or statement affecting nomenclature is the date on which the publication 
was mailed to subscribers, placed on sale, or when the whole edition is distributed free of charge, 
mailed to institutions and individuals to whom free copies are distributed. The mailing date, not the 
printing date, is the correct one.

The printing date of this volume: March 2004

The mailing dates of recent Proceedings of the Ocean Drilling Program:
Volume 204 (Initial Reports): November 2003
Volume 205 (Initial Reports): November 2003
Volume 206 (Initial Reports): December 2003
Volume 177 (Scientific Results): March 2003
Volume 183 (Scientific Results): June 2003
Volume 186 (Scientific Results): October 2003

Copies of this publication may be obtained from Publications Distribution Center, Ocean Drilling 
Program, Texas A&M University, 1000 Discovery Drive, College Station TX 77845-9547, USA. See the 
ODP publication list at www-odp.tamu.edu/publications or contact ODP for prices and ordering 

information. Orders for copies require advance payment.

ISSN
Book: 0884-5883; CD-ROM: 1096-2522; World Wide Web: 1096-2158
Library of Congress 87-642-462

http://www-odp.tamu.edu/publications
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PUBLISHER’S NOTES
This volume also appears on the World Wide Web. Any scientific corrections, revisions, or additions 
will be noted in the chapter (see “Chapter Notes”) at www-odp.tamu.edu/publications.

This publication was prepared by the Ocean Drilling Program, Texas A&M University, as an account of 
work performed under the international Ocean Drilling Program, which is managed by Joint 
Oceanographic Institutions, Inc., under contract with the National Science Foundation. Funding for 
the program was provided by the following agencies at the time of this cruise:

Australia/Canada/Chinese Taipei/Korea Consortium for Ocean Drilling: Department of Primary Industries and 
Energy (Australia), Natural Resources Canada, National Taiwan University in Taipei, and Korean Institute for 
Geology, Mining and Minerals

Deutsche Forschungsgemeinschaft (Federal Republic of Germany)

European Science Foundation Consortium for Ocean Drilling (Belgium, Denmark, Finland, Iceland, Ireland, Italy, 
The Netherlands, Norway, Portugal, Spain, Sweden, and Switzerland)

Institut National des Sciences de l’Univers–Centre National de la Recherche Scientifique (INSU-CNRS) (France)

Marine High-Technology Bureau of the State Science and Technology Commission of the People’s Republic of 
China
National Science Foundation (United States)

Natural Environment Research Council (United Kingdom)

University of Tokyo, Ocean Research Institute (Japan)

http://www-odp.tamu.edu/publications
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Any opinions, findings, and conclusions or recommendations expressed in this publication are those of 
the author(s) and do not necessarily reflect the views of the National Science Foundation, the 
participating agencies, Joint Oceanographic Institutions, Inc., Texas A&M University, or Texas A&M 
Research Foundation.

Abbreviations for names of organizations and publications in ODP reference lists follow the style given 
in Chemical Abstracts Service Source Index (published by American Chemical Society).

The bulk of the shipboard-collected data from this leg is available on the World Wide Web and is 
accessible at www-odp.tamu.edu/database. If you cannot access this site or need additional data, 
please contact the ODP Data Librarian, Ocean Drilling Program, Texas A&M University, College 
Station TX 77845-9547, USA. E-mail: database@odpemail.tamu.edu.

Some core close-up photographs have been tonally enhanced to better illustrate particular features of 
interest.

Supplemental data on the volume CD-ROM were provided by the authors and may not conform to 
ODP publication formats.

A site map showing the drilling locations for this leg and maps showing the drilling locations of all 
Ocean Drilling Program (ODP) and Deep Sea Drilling Project (DSDP) drilling sites are available on the 
volume CD-ROM in PDF format. These maps were produced using Generic Mapping Tools (GMT) of 

Paul Wessel and Walter H.F. Smith (gmt.soest.hawaii.edu).

Cover photograph (interval 207-1258B-53R-1, 8–28 cm) shows a Cretaceous black shale with 
concentrations of preserved fish debris and phosphoritic nodules (coproliths). The photograph was 
taken by ODP Photographer Cindi Prince.

http://www-odp.tamu.edu/database
mailto:database@odpemail.tamu.edu
http://gmt.soest.hawaii.edu


8

FOREWORD

BY JOINT OCEANOGRAPHIC INSTITUTIONS, INC.

This volume presents scientific and engineering results from the Ocean Drilling Program (ODP). These results 
address the scientific and technical goals of the program, which are focused on the study of the dynamics of 
Earth’s interior and environment, the evolution of oceanic crust, and the fluctuations of climate. In addition, 
study of the Earth’s deep biosphere is an emergent research objective.

ODP, an international partnership of scientists and research institutions from 22 countries, operates the drillship 
JOIDES Resolution. This state-of-the-art research vessel contains eight levels of laboratories and other scientific 
facilities required for carrying out the program’s objectives.

The management of ODP involves a partnership of scientists and governments. International oversight and 
coordination are provided by the ODP Council, which is made up of representatives from the member 
countries. Overall scientific and management guidance is provided by representatives from the Joint 
Oceanographic Institutions for Deep Earth Sampling (JOIDES).

Joint Oceanographic Institutions, Inc. (JOI), a nonprofit consortium of 18 U.S. oceanographic institutions, serves 
as the National Science Foundation’s prime contractor for ODP. JOI implements scientific objectives, plans, and 
recommendations of the JOIDES committees through major subcontracts to Texas A&M University (TAMU) for 

science operations and to Lamont-Doherty Earth Observatory (LDEO) of Columbia University for geochemical 
and geophysical well-logging services.

JOI, TAMU, and LDEO have worked together successfully for many years to manage the Ocean Drilling 
Program. We look forward to many exciting discoveries and continued international collaboration as we further 
our scientific mission, especially the planning for the future of ocean drilling beyond 2003.

Steven R. Bohlen
President of the Joint Oceanographic Institutions and Executive Director of the Ocean Drilling Programs
Washington, D.C.
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OCEAN DRILLING PROGRAM*
National Science Foundation
4201 Wilson Boulevard
Arlington VA 22230, USA
Tel: (703) 306-1581; Fax: (703) 306-0390
Web site: www.nsf.gov

MEMBER ORGANIZATIONS OF THE JOINT OCEANOGRAPHIC INSTITUTIONS FOR DEEP EARTH 
SAMPLING (JOIDES)

Columbia University, Lamont-Doherty Earth 
Observatory

Florida State University

Oregon State University, College of Oceanic and 
Atmospheric Sciences
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University of California, Santa Cruz

University of Florida

University of Hawaii, School of Ocean and Earth 
Science and Technology
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Stanford University, School of Earth Sciences

Texas A&M University, College of Geosciences

University of California at San Diego, Scripps 
Institution of Oceanography

University of Michigan, College of Literature, 
Science, and the Arts

University of Rhode Island, Graduate School of 
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*At completion of ODP cruises in September 2003. See Publisher’s Notes, p. 6, for list of funding agencies at time of 
cruise.

http://www.nsf.gov/
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University of Washington, College of Ocean and 
Fishery Sciences

Woods Hole Oceanographic Institution

Federal Republic of Germany, Bundesanstalt für 
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France, Institut National des Sciences de 
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l’Univers–Centre National de la Recherche 
Scientifique (INSU-CNRS)

Japan, University of Tokyo, Ocean Research 
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People’s Republic of China, Marine High-
Technology Bureau of the State Science and 
Technology Commission of the People’s 
Republic of China

United Kingdom, Natural Environment Research 
Council 
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E-mail: info@joiscience.org
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ODP SITE SURVEY DATA BANK

Lamont-Doherty Earth Observatory
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PO Box 1000, 61 Route 9W
Palisades NY 10964, USA
Tel: (845) 365-8542; Fax: (845) 365-8159
E-mail: odp@ldeo.columbia.edu
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mailto:info@joiscience.org
http://www.joiscience.org
mailto:odp@odpemail.tamu.edu
http://www-odp.tamu.edu/
mailto:borehole@ldeo.columbia.edu
http://www.ldeo.columbia.edu/BRG/ODP
mailto:odp@ldeo.columbia.edu
http://www.ldeo.columbia.edu/databank
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Texas A&M University
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*Addresses at time of cruise, except where updated by the leg participants before publication.

mailto:erbacher@bgr.de
mailto:dmosher@nrcan.gc.ca
mailto:malone@iodp.tamu.edu
mailto:debora@ocean.tamu.edu
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CD-ROM CONTENTS: CORE DESCRIPTIONS
Visual core descriptions (VCDs), smear slide and thin section data tables, and digital images are 
included in this section. VCDs, smear slide data tables, and thin sections are combined into one PDF 
file for each site. ASCII versions of the smear slide data tables are included in the VOLUME\TABLES 
directory (see “ASCII Tables”).

Site 1257

Visual Core Descriptions · Smear Slides · Thin Sections 

Site 1258
Visual Core Descriptions · Smear Slides · Thin Sections 

Site 1259

Visual Core Descriptions · Smear Slides · Thin Sections 

Site 1260

Visual Core Descriptions · Smear Slides · Thin Sections 

Site 1261

Visual Core Descriptions · Smear Slides · Thin Sections 
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CD-ROM CONTENTS: ASCII TABLES
The Initial Reports CD-ROM contains ASCII  versions of edited paleomagnetism, P-wave velocity, and 
index properties data tables from the site chapters and all of the smear slide data tables presented 
under “Core Descriptions.” A complete listing of the ASCII tables can be found listed below. 

You can access these data directly from the PDF files. Depending on your computer platform, the 
following information applies.

PC COMPUTERS
By default, double-clicking on a filename with a .TXT extension will launch the Notepad application. 
You can configure your computer’s operating system so that files on this CD with .TXT extensions 
automatically open in other software, such as Microsoft Excel. Follow these steps from the pull-down 
menu: Windows 95 and NT operating systems: View > Options > File Types; and Windows 98, 2000, 
ME, and XP systems: View > Folder Options > File Types.
MACINTOSH COMPUTERS
All table files with .TXT extensions will automatically open into Excel. If you do not have Excel installed 
on your computer, you may view these files through other spreadsheet or text-editor programs. Open 
the application of your choice, select File > Open, and open the ASCII file.

UNIX COMPUTERS
You can open files with .TXT extensions in any text editor or spreadsheet program but not directly 
from PDF files.

Chapter 4 Chapter 7 Smear slide data tables

Chapter 5 Chapter 8 Thin section data tables

Chapter 6 
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Chapter 4, Site 1257
Table T20. Index properties of discrete samples, Site 1257.
Table T21. Discrete measurements of P-wave velocity, Site 1257.

Chapter 5, Site 1258
Table T21. Index properties of discrete samples, Site 1258.

Table T22. Discrete measurements of P-wave velocity, Site 1258.

Chapter 6, Site 1259
Table T20. Moisture and density of discrete samples, Site 1259.
Table T22. Discrete measurements of P-wave velocity, Site 1259.

Chapter 7, Site 1260
Table T20. Index properties of discrete samples, Site 1260.
Table T21. Discrete measurements of P-wave velocity, Site 1260.

Chapter 8, Site 1261
Table T18. Index properties of discrete samples, Site 1261.
Table T20. Discrete measurements of P-wave velocity, Site 1261.
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Smear Slide Data Tables
Hole 1257A smear slide table.
Hole 1257B smear slide table.
Hole 1257C smear slide table.
Hole 1258A smear slide table.
Hole 1258B smear slide table.
Hole 1258C smear slide table.
Hole 1259A smear slide table.

Hole 1259B smear slide table.
Hole 1259C smear slide table.
Hole 1260A smear slide table.
Hole 1260B smear slide table.
Hole 1261A smear slide table.
Hole 1261B smear slide table.

Thin Section Data Tables
Site 1257 thin section table.
Site 1258 thin section table.
Site 1259 thin section table.
Site 1260 thin section table.
Site 1261 thin section table.
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CD-ROM CONTENTS: OVERSIZED MATERIAL
These oversized figures and tables are available on the volume CD-ROM in PDF format.

Chapter 4
Figure F8. Shipboard paleomagnetic data and initial interpretations of inclination clusters of the 

Oligocene–Cretaceous from Holes 1257A, 1257B, and 1257C.
Table T4. Distribution of planktonic foraminifers, Hole 1257A.

Chapter 5
Figure F11. Shipboard paleomagnetic data and initial interpretations of inclination clusters of the 

Eocene–Cretaceous of Holes 1258A, 1258B, and 1258C.
Table T4. Distribution of planktonic foraminifers, Hole 1258A.
Table T7. Distribution of planktonic foraminifers, Hole 1258B.
Table T10. Characteristic directions of minicores, Holes 1258A and 1258B.

Chapter 6

Figure F12. Shipboard paleomagnetic data and initial interpretations of inclination clusters of 

the Cretaceous–Miocene from Holes 1259A, 1259B, and 1259C.
Table T4. Distribution of planktonic foraminifers, Hole 1259A.

Chapter 7
Figure F11. Shipboard paleomagnetic data and initial interpretations of inclination clusters in the 

Cretaceous–Oligocene of Holes 1260A and 1260B.
Table T4. Distribution of planktonic foraminifers, Hole 1260A.
Table T8. Distribution of planktonic foraminifers, Hole 1260B.

Chapter 8
Figure F9. Shipboard paleomagnetic data and initial interpretations of inclination clusters in the 

Cretaceous–Miocene from Holes 1261A and 1261B.
Table T4. Distribution of planktonic foraminifers, Hole 1261A.
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CD-ROM CONTENTS: SUPPLEMENTARY MATERIAL
The Initial Reports CD-ROM contains supplementary data files presented as Excel 97/98 spreadsheets. 
The files present expanded coring summary tables, MST splice tables, and radiolarian paleontological 
data. Supplementary material files are located in the SUPP_MAT directory.

COR_SUMM
1257ECS.XLS
1258ECS.XLS
1259ECS.XLS
1260ECS.XLS
1261ECS.XLS

MST_SPL
1257MST
1257DATA
GRA1257A.XLS
GRA1257B.XLS
GRA1257C.XLS

RSC1257A.XLS
RSC1257B.XLS
RSC1257C.XLS

1257SPL
GRA_SPL.DAT
MSL_SPL.DAT
NCR_SPL.DAT
NGR_SPL.DAT
RAT_SPL.DAT
RSC_SPL.DAT

1258MST
1258DATA
MSL1257A.XLS
MSL1257B.XLS
MSL1257C.XLS
NCR1257A.XLS
NCR1257B.XLS
NCR1257C.XLS
NGR1257A.XLS
NGR1257B.XLS
NGR1257C.XLS
RAT1257A.XLS
RAT1257B.XLS
RAT1257C.XLS

GRA1258A.XLS
GRA1258B.XLS
GRA1258C.XLS
MSL1258A.XLS
MSL1258B.XLS
MSL1258C.XLS
NCR1258A.XLS
NCR1258B.XLS
NCR1258C.XLS
NGR1258A.XLS
NGR1258B.XLS
NGR1258C.XLS
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RAT1258A.XLS
RAT1258B.XLS
RAT1258C.XLS
RSC1258A.XLS
RSC1258B.XLS
RSC1258C.XLS

1258SPL
GRA_SPL.DAT
MSL_SPL.DAT
NCR_SPL.DAT
NGR_SPL.DAT
RAT_SPL.DAT
RSC_SPL.DAT

1259MST
1259DATA
GRA1259A.XLS
GRA1259B.XLS
GRA1259C.XLS

1259SPL
GRA_SPL1.DAT
GRA_SPL2.DAT
GRA_SPL3.DAT
MSL_SPL1.DAT
MSL_SPL2.DAT
MSL_SPL3.DAT
NGR_SPL1.DAT
NGR_SPL2.DAT
NGR_SPL3.DAT
RAT_SPL1.DAT
RAT_SPL2.DAT
RAT_SPL3.DAT
RSC_SPL1.DAT
RSC_SPL2.DAT
RSC_SPL3.DAT

1260MST
1260DATA
MSL1259A.XLS
MSL1259B.XLS
MSL1259C.XLS
NGR1259A.XLS
NGR1259B.XLS
NGR1259C.XLS
RAT1259A.XLS
RAT1259B.XLS
RAT1259C.XLS
RSC1259A.XLS
RSC1259B.XLS
RSC1259C.XLS

GRA1260A.XLS
GRA1260B.XLS
MSL1260A.XLS
MSL1260B.XLS
NGR1260A.XLS
NGR1260B.XLS
RAT1260A.XLS
RAT1260B.XLS
RSC1260A.XLS
RSC1260B.XLS
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1260SPL
GRA_SPL1.DAT
GRA_SPL2.DAT
GRA_SPL3.DAT
MSL_SPL1.DAT
MSL_SPL2.DAT
MSL_SPL3.DAT
NGR_SPL1.DAT
NGR_SPL2.DAT
NGR_SPL3.DAT

MSL1261B.XLS
NGR1261A.XLS
NGR1261B.XLS
RAT1261A.XLS
RAT1261B.XLS
RSC1261A.XLS
RSC1261B.XLS

1261SPL
GRA_SPL.DAT
MSL_SPL.DAT
RAT_SPL1.DAT
RAT_SPL2.DAT
RAT_SPL3.DAT
RSC_SPL1.DAT
RSC_SPL2.DAT
RSC_SPL3.DAT

1261MST
1261DATA
GRA1261A.XLS
GRA1261B.XLS
MSL1261A.XLS

NGR_SPL.DAT
RAT_SPL.DAT
RSC_SPL.DAT

PAL_RAD
1257RAD.XLS
1258RAD.XLS
1259RAD.XLS
1260RAD.XLS
1261RAD.XLS

README.TXT
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CD-ROM CONTENTS: DRILLING LOCATION MAPS
A site map showing the drilling locations for this leg and maps showing the drilling locations of all 
Ocean Drilling Program (ODP) and Deep Sea Drilling Project (DSDP) drilling sites are available in PDF 
format.

ODP Leg 207 Site Map 

ODP Map (Legs 100–207)

DSDP Map (Legs 1–96)
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RELATED LEG DATA

DOWNHOLE LOGGING AND CORE DATA 

A CD-ROM containing processed logging data and a subset of core data is included with the printed 
version of this volume. However, a more complete set of the logging data collected by ODP Logging 
Services is available online at www.ldeo.columbia.edu/BRG/ODP/DATABASE/DATA/search.html. If 
you have problems downloading the data, wish to receive additional logging data, or have questions 
regarding the data, please contact: Data Services Manager, ODP Logging Services, Borehole Research 
Group, Lamont-Doherty Earth Observatory of Columbia University, PO Box 1000, 61 Route 9W, 
Palisades NY 10964, USA; Tel: (845) 365-8343; Fax: (845) 365-3182; E-mail: 
logdb@ldeo.columbia.edu.

The majority of the core data on the CD are available on the Web at www-odp.tamu.edu/database. 

If you cannot access the ODP database or need additional data, please contact: ODP Data Librarian, 
Ocean Drilling Program, Texas A&M University, 1000 Discovery Drive, College Station TX 77845-
9547, USA; Tel: (979) 845-8495; Fax: (979) 458-1617; E-mail: database@odpemail.tamu.edu.

COMPILED ELECTRONIC INDEX
The Compiled Electronic Index of the Proceedings of the Ocean Drilling Program included on the volume 
CD-ROM contains individual indexes of Volumes 101–178, 180, 183, and 186. The indexes are 
contained in the directory titled ODPINDEX and are named ###NDX.PDF (### = the leg number). 
These indexes can be searched individually or collectively.

http://www.ldeo.columbia.edu/BRG/ODP/DATABASE/DATA/search.html
mailto:logdb@ldeo.columbia.edu
http://www-odp.tamu.edu/database
mailto:database@odpemail.tamu.edu
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CD-ROM DIRECTORY STRUCTURE 

ACROREAD
(Acrobat Reader installation 
software and instructions for 
different platforms)

207IR.PDF
(Preliminary pages and table of contents)

README.TXT

IR207_01.PDF (Leg 207 Summary)VOLUME
(Leg 207 Initial Reports volume)

README.PDF
(Information about the volume CD-ROM)

README.TXT
(ASCII version of information about the volume CD-ROM)

MAPS
(Drilling location maps) ODPMAP.PDF (ODP map, Legs 100 through 207)

CHAPTERS
(Volume chapters)

207_MAP.PDF (Leg 207 site map)

IR207_02.PDF (Explanatory Notes)

IR207_03.PDF (Site Survey and Underway
Geophysics)

IR207_04.PDF (Site 1257)

IR207_05.PDF (Site 1258)

IR207_06.PDF (Site 1259)

DSDPMAP.PDF (DSDP map, Legs 1 through 96)

TABLES
(ASCII versions of paleomagnetism,
P-wave velocity, index properties,
smear slide, and thin section data
tables)

IR207_04 (Site 1257 files)

IR207_05 (Site 1258 files)

IR207_06 (Site 1259 files)

S_SLIDES (Sites 1257 through 1261)

T_SECT (Sites 1257 through 1261)

README.TXT

(Continued on next page)

OVERSIZE
(Large-format figures and tables)

IR207_04 (Site 1257 files)

IR207_05 (Site 1258 files)

COR_1257.PDF (Site 1257)CORES
(Visual core descriptions, smear
slide data tables, thin section data
tables, and digital core images)

COR_1258.PDF (Site 1258)

COR_1259.PDF (Site 1259)

IMAGES (PDF files of core images)

IR207_07.PDF (Site 1260)

IR207_08.PDF (Site 1261)

COR_1260.PDF (Site 1260)

COR_1261.PDF (Site 1261)

IR207_08 (Site 1261 files)

IR207_07 (Site 1260 files)

MAC

UNIX

WINDOWS

IR207_09.PDF (Microbial Gases)

IR207_10.PDF (Hydrocarbon Biomarkers)

IR207_06 (Site 1259 files)

IR207_07 (Site 1260 files)

IR207_08 (Site 1261 files)

INDEX.PDX
(Acrobat file used to enable Acrobat Search of the
Leg 207 Initial Reports)
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CD-ROM DIRECTORY STRUCTURE (CONTINUED).

ODPINDEX
(Compiled Electronic Index of the
Proceedings of the Ocean Drilling
Program)

SUPP_MAT
(Supplementary Material)

COR_SUMM
(Expanded coring summary tables in
Excel)

1257ECS.XLS

1258ECS.XLS

101NDX.PDF through 178NDX.PDF,
180NDX.PDF, 183NDX.PDF, and 186NDX.PDF
(Index files)

NDX.PDX
(Acrobat file used to enable Acrobat Search of the
Compiled Electronic Index)

1259ECS.XLS

1260ECS.XLS

1261ECS.XLS

MST_SPL
(MST splice tables in Excel)

1257MST (Site 1257 files)

1258MST (Site 1258 files)

1259MST (Site 1259 files)

1260MST (Site 1260 files)

1261MST (Site 1261 files)

PAL_RAD
(Radiolarian tables in Excel)

1257RAD.XLS

1258RAD.XLS

1259RAD.XLS

1260RAD.XLS

1261RAD.XLS

README.TXT


	Volume 207 Initial Reports
	Frontispiece
	Title Page
	Citations
	Publication Dates
	Publisher’s Notes
	Foreword
	Ocean Drilling Program
	NSF
	Member Organizations of (JOIDES)
	ODP Program Manager
	ODP Science Operator
	ODP Logging Services Operator
	ODP Site Survey Data Bank

	Leg 207 Participants
	Shipboard Scientific Party
	Transocean Officials
	ODP Shipboard Personnel

	Publication Services Staff
	Acknowledgments
	CD-ROM Contents
	Chapters
	1. Leg 207 Summary
	2. Explanatory Notes
	3. Site Survey and Underway Geophysics: Demerara Rise, Leg 207
	4. Site 1257
	5. Site 1258
	6. Site 1259
	7. Site 1260
	8. Site 1261
	9. Microbial Gases in Black Shale Sequences on the Demerara Rise
	10. Molecular Biogeochemistry of Cretaceous Black Shales from the Demerara Rise: Preliminary Shipboard Results from Sites 1257 and 1258, ODP Leg 207

	Core Descriptions
	ASCII Tables
	Oversized Material
	Supplementary Material
	Drilling Location Maps

	Related Leg Data
	Downhole Logging and Core Data

	Compiled Electronic Index
	CD-ROM Directory Structure
	CD-ROM Directory Structure (continued).


	Readme file

